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DirCmp.pdf, are copyrighted: 

Copyright © Juan M. Aguirregabiria 1997-2014 

All rights reserved 

Other brand and product names are trademarks or registered trademarks of their repective 
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Version history 

New in version 3.47 

 New File/Create shortcut menu to create shortcuts (for automatic backups, ...) 

and to prepare arguments for Directory Compare, batch files, etc. 

New in version 3.46 

 Bug fix. 

New in version 3.45 

 Minor bug fixes. 

 Customizable file size format through Options/Main list: File size format, Sep-

arator and Even when they are different. 

 File/Export can now create CSV files if the .csv extension is used. 

 Any number of exact hours can be ignored when comparing FAT and NTFS vol-

umes. 

 Swap menu entry moved from File to Edit. 

 New speed button: Options/Preferences. 

New in version 3.44 

 Fixes for bugs introduced by the upgraded compiler. 

New in version 3.43 

 Minor bug fixes. 

New in version 3.42.2 

 New menu entries in Edit and popup menu: Open/source and target directo-

ries, Open/source directory/directories, Open/target directory/directories. 

New in version 3.42 

 New options in Options/Unattended mode: Check drive ready status and 

Check folders exist. 

 New menus (in Edit and the popup): Exclude directories and Exclude file type. 

 Optionally the setup program will install several styles (skins) which change the 

program appearance. You can also find more in internet: see, for instance, 

http://theroadtodelphi.wordpress.com/2011/09/01/exploring-delphi-xe2-vcl-

styles-part-i/ or http://code.google.com/p/vcl-styles-

utils/wiki/VclStylesCollection.The current style (as well as the use of animations 

in lengthy operations) is selected from the Options dialog box. 

New in version 3.41 

 New File attributes that cannot be copied section in the help file and documen-

tation. 

 If the program is launched with any command line option the Allow a single 

program instance option is ignored. 

 By using the command line (for automatic backups, for instance) a command may 

be executed after the synchronization (for instance to shut down or hibernate the 

computer). 

http://theroadtodelphi.wordpress.com/2011/09/01/exploring-delphi-xe2-vcl-styles-part-i/
http://theroadtodelphi.wordpress.com/2011/09/01/exploring-delphi-xe2-vcl-styles-part-i/
http://code.google.com/p/vcl-styles-utils/wiki/VclStylesCollection
http://code.google.com/p/vcl-styles-utils/wiki/VclStylesCollection


New in version 3.40 

 Check for updates from a menu or automatically at prescribed times. 

New in version 3.39.1 

 Fixed bug when reading file attributes. 

New in version 3.39 

 User defined date and time format. 

 Friendlier selection of the external compare program. 

New in version 3.38 

 New option, Use Explorer view, to provide an alternative way to select directo-

ries. 

 New option, Show grid lines, to separate entries in the main list. 

 Now wildcards can be used in excluded source and target directories. 

New in version 3.37 

 Warning on changed .dcp files is now optional. 

New in version 3.36 

 New menu. 

 Warning when a .dcp file has changed. 

 Fixed bug in the /e command line option. 

New in version 3.35 

 Refresh works also from the context menu. 

 The Multiple dialog box is now resizable. 

 A warning is issued if a source/target/excluded directory is not found. 

 The settings Display icons, List, Copy and Delete directories and  Automati-

cally update... are also written to and read from .dcp files. 

 New menu: Mirror selected. 

New in version 3.34 

 Export fixed. 

New in version 3.33 

 Minor improvements in user interface. 

New in version 3.32 

 Columns may be rearranged. 

 New Refresh menu. 

New in version 3.31 

 Bug fixes. 

New in version 3.30 

 Windows 95, 98, Me and NT are no longer supported. 

 Source and target directories can be dragged from Explorer (and other programs) 

and dropped over Directory Compare. 



 New command line options /h to run Directory Compare hidden for automatic 

backups. 

 Full Unicode support.  

 Improved detection of empty drives or unplugged USB discs. 

 Options are no longer stored in the registry. 

 Options can be saved in a portable device 

New in version 3.26 

 Minor bug fixes 

New in version 3.25 

 Fixed bug after cancelling a scan with multiple Source/Target directories 

New in version 3.24 

 Fixed memory bug when comparing equal files 

 Stable sort: sorting by a new column doesn’t mix up other columns ordering 

 Minor bug fixes 

New in version 3.23 

 Fixed bug with selected items are sorted 

New in version 3.22 

 Fixed bug with 0 length files 

 Fixed bug with file names starting with a space 

New in version 3.21 

 Much faster sorting of very long lists 

New in version 3.20 

 Much faster handling of very long lists 

 Fixed handling of very large files 

New in version 3.13 

 Implemented some Vista features: large icons... 

 Workaround for bug in Windows XP update 

New in version 3.12 

 New Change in selected menus. 

New in version 3.11 

 Improved Vista compatibility 

New in version 3.10 

 New help system (hopefully compatible with Vista). 

 Compiled with old compiler to avoid bug in files starting or ending with spaces. 

New in version 3.09 

 You can be informed of the copy process (especially useful for large files). 

 Read-only files can (optionally) be deleted/overwritten in unattended mode. 

New in version 3.06 



 /D command line options. 

New in version 3.05 

 Minor bug fixes. 

New in version 3.04 

 Minor bug fixes. 

New in version 3.03 

 New option, Ignore differences of 2 hours when comparing FAT and NTFS 

volumes, deal with some nasty cases due to the different ways daylight saving 

time is managed. 

 Fixed bug in Guess. 

New in version 3.02 

 New menu entry, Options/History list, to clean up the lists of most recently used 

.dcp files, source directories, file filters and target directories. 

 Minor bug fixes. 

New in version 3.01 

 Improved Multiple Source/Target pairs dialog. You can now exclude directo-

ries from the source and the target trees. 

 The progress dialog displayed when scanning directories is much more informa-

tive now. 

 Workaround for a bug in C++ Builder 6, which led to scrambled main list when 

one column width was changed. 

 Miscellaneous minor bug fixes. 

New in version 3.00 

 Multiple Source/Target pairs. 

 You may specify which directories (and files) will be excluded form the scan. 

 Greatly improved unattended automatic backups: no message box, log facilities, 

etc. 

 New command line options. 

 Minor user interface improvements. 

 Miscellaneous bug fixes. 

However, some features are no longer supported: 

 No zip file support (it was provided by a third-party component, but it no longer 

works with my current compiler). 

 No drag and drop from the program support (for the same reason). 

 Only WinHelp is supported in the help system (I personally prefer this format and 

do not have the time to update two sets of help files) 

 The program will now always use long file names (it was about time to forget 

about 8.3 format). 

New in version 2.54 



 Scan is started if <Enter> is pressed in the text boxes of Source, Filter or Tar-

get. 

 File/Swap now works even if no newer or no older file exists. 

New in version 2.53 

 The sort order of the main list is now saved from scan to scan and, optionally, 

from session to session. 

New in version 2.52 

 Zip files were not correctly handled if they were the Source (rather than the Tar-

get). 

New in version 2.51 

 The new Export entry of the File menu can be used to save the main list contents 

to a text file from where it can be read into Word table, Excel or any other data 

processor. 

New in version 2.5 

 Files and directories can be dragged from Directory Compare to any window 

accepting dropped files (such as the desktop, or My Computer and Explorer 

views) where they are copied, moved or referenced by a new shortcut. 

New in version 2.45 

 Fixed bug when comparing directories. 

New in version 2.44 

 Improved Explorer context menus. 

New in version 2.43 

 Fixed bug when copying/deleting directories. 

New in version 2.42 

 Fixed bug when comparing directories. 

New in version 2.40 – 2.41 

 Two new menu items provide most of the features in the context menu that dis-

plays when right clicking on items in a My Computer or Explorer view. 

 You can now open (and compare with an external program) zipped files. 

 Settings are now saved when the Windows session ends. 

 More consistent menu activation. 

New in version 2.31 

 Fixed bug in the handling of most recently used files. 

New in version 2.30 

 Now file patterns may also be excluded in Filter. 

 You can specify the Filter in the command line. 

New in version 2.24 

 Added File/Print. 

New in version 2.23 



 Fixed bug in the Copying Files dialog box design. 

New in version 2.22 

 New speed button and short-cut key for Mirror. 

 More informative message when a NT user without administrative privileges tries 

to change the context menu settings in Options/Configure/Miscellaneous. 

 Entering a path in a non-existing drive in Source or Target does not produce 

garbage. 

New in version 2.21 

 Left and right scrolling did not work.  

New in version 2.20 

 New features: 

o A new Options sheet (Color) let you use colors to mark (with user-

defined colors) entries with newer Source or Target. 

 Fixed bugs: 

o The HTML help should now run with all library versions supporting it.  

o The HTML help does not appear always over the current window. 

New in version 2.10 

 A new menu entry (Mirror) and a new command line option (/M) make easier 

getting exact copies of Source. 

New in version 2.00 

 A zip file may be used instead of the Source or the Target directory. 

 With the enhanced command line options it may be used in unattended mode for 

automatic backups. 

 Relative paths are now handled in the right way. 

New in version 1.53 

 The ability to allow running only one copy of the program. 

 A (partial) solution for the problem with daylight savings under NT. 

 The Ignore differences under setting is only used when Source and Target are 

under different file systems.  

 When comparing files, the update was not always possible.  

New in version 1.52 

 All different style bits are reported when comparing files. 

 It is possible to control from which directory will start the search for the source or 

target directory when using the Source and Target buttons.  

New in version 1.51 

 Ask the user before launching (comparing) more than one pairs of items from the 

main list. 

New in version 1.50 

 Fixed bug in Windows API shell functions when writing to CD-RWs. 



 Optional entries in the context menus of folders to select them as source or target 

directory. 

 Directories may be listed along with files. In that way they can be copied (even if 

they are empty) or deleted. 

 Richer command line syntax. 

 Attributes (as well as sizes, time stamps, contents and even file existence) can be 

ignored when comparing files (useful when the source/target is a CD-ROM). 

 Minor changes in menus, tool tips, options. . . 

New in version 1.48 

 Fixed handling of time stamps. 

 Optional Windows98-style HTML help system. 

New in version 1.47 

 Fixed handling of Filters containing paths (a legal practice that may have unex-

pected results). 

 Ignore time differences under should now work correctly. 

New in version 1.46 

 Incorrect directories were created when the source or target was in the form d:\. 

 Now only the options in the first sheet of Options are stored in a .dcp file. 

 Now it is possible to erase/eliminate separately the source and target items 

 It is possible to instruct the program to forget its current position and dimensions 

 Old DOS/Win3+ short file names are now supported 

New in version 1.43 

 New compiler version and some cosmetic changes: AVIs and colorful buttons. 

New in version 1.42 

 The first time the program was used Scan was not activated until something was 

typed. 

New in version 1.41 

 The most-recently-used list now works. 

 The Swap menu entry also swaps labels and the contents of the main list. 

New in version 1.40 

 A new option on the File menu allows swapping source and target directories. 

 New options on the Edit and shortcut menus to open/view source and/or target 

files and to send them to an external compare program. 

 A new sheet in the Options dialog allows selecting the meaning of a double click 

on an item in the main list. 

 A new option on the Options dialog allows comparing files exclusively by their 

name. 

New in version 1.32 

 A stupid message issued when a .dcp file was directly open has been removed. 



 A new entry in the Options dialog allows ignoring small differences between 

time stamps that are generated by the different precision NT and Win95/98 use to 

save them. 

 A single click on the right spot of the About dialog is enough to e-mail me or 

browse my home page. 

New in version 1.31 

 It tried to delete some no existing Target files when using Delete or Eliminate. 

 The Synchronize operations did not update the Target if Source had been updat-

ed. 

New in version 1.30 

 It was possible to select commands while the main list was being built. 

 The main list will optionally display the icons corresponding to each item. It is al-

so possible to disable continuous updating of its contents. 

 The Filter may contain several file masks separated by ; 

New in version 1.20 

 New Options menu and dialog. 

 The sorting order by the ? field is now user configurable in the new Options dia-

log box. 

 Files with the same time stamps but different sizes or attributes can be optionally 

considered as newer source files. 

 Errors comparing file contents are now more explicit and the possibility to update 

the target is now offered. It is also possible to invoke an external program to 

compare in more detail the files. 

New in version 1.10 

 Correct handling of blank string in combo boxes. 

 The Filter specification history is now correctly handled. 

 The relative path of files is shown in a separate field.  

 One can reorder the items by clicking columns headers.  

 More information is saved from session to session, including main window posi-

tion and dimension, the width of columns in the list of files and their sort mode.  

New in version 1.01 

 The keyboard short-cut to delete items has been changed form Del to Ctrl+D to 

avoid inadvertently deleting files when editing the target, filter or source specifi-

cations. Other short-cuts have also been changed. 

 The main window is now resizable.  



Introduction 

Directory Compare is a utility to help you keeping copies of your important directories 

(documents, programs under development and so on) in a backup hard disk or any other 

storage system (like USB drives or CD-RW disks). The copy may be made 

(semi)automatically or in an interactive way. 

I always have two or more copies of my important documents and I refresh them very of-

ten. I prefer to save exact copies of my working directories (rather than using some back-

up program), because it is faster and makes easier to open the old copy to recover some 

element or part that was better in the previous version. To make this process easier I 

wrote, many years ago, the first version of the program cpy which is included with my 

Console Utilities. Cpy is a command line program, which makes it very convenient to 

use from a desktop shortcut that after a single click copies to my backup hard disk all 

modified elements in my working directories. Users who do not want to remember com-

mand lines options may use Cmd Line Shell to have a more user-friendly interface.  

Directory Compare is a kind or GUI version of cpy: it has more options and its visual 

interface makes it easier to do selective copies. For instance, modern compilers generate 

an incredible amount of auxiliary data, which speeds up compilation, but takes a lot of 

storage space.  (For instance, the source files of Directory Compare are less than100 

Kb, but the auxiliary files generated by the compiler occupy 7,500 Kb!) Usually you do 

not want such files in your backup disk: they are very large and can be easily recreated by 

running the compiler.  

Cpy may be instructed to ask you for confirmation before copying each file, but this is a 

boring and error prone process. My strategy is to use cpy to copy everything during pro-

gram development and then, when I release the software, I delete auxiliary files from my 

main and backup disks. To improve this approach I wrote Directory Compare: it shows 

you, side by side, the source and backup directories so that you can easily select the files 

to by copied (from the source to the target or in both directories) and even delete from 

both directories auxiliary files. 



Installing Directory Compare 

To install the program in your hard drive run the setup program and follow the 

 ompare tions. It will copy to the directory you select the executable file, 

DirCmp.exe, the help files, DirCmp.chm, and the documentation file, 

DirCmp.pdf.  

The first time the program is run you are invited to check the Options dialog box that 

opens from the Options/Configure menu.  

 

Running Directory Compare from a portable device 

The program can be also run from a portable device (such as a USB drive) or an account 

with limited privileges.  

1. Copy (from your hard disk or the portable distribution dslvr???.zip) the files 

dircmp.exe, dircmp0.ini, dircmp.chm and optionally dircmp.pdf to any folder in 

the device (or computer). 

2. Rename dircmp0.ini to dircmp.ini (depending on your Explorer settings) you may 

not see the .ini extension).  

The options will be stored from session to session in dircmp.ini, instead of using, on a 

per user basis, a file like C:\Users\user\AppData\Roaming\Juan M. 

Aguirregabiria\dircmp.ini).  

This is convenient when the program is used from the portable device in a computer 

where the program has not been installed or from an account with limited privileges that 

won’t allow installing the program; but some things will be still missing: mainly the abil-

ity to store settings and preferences on a per user basis, the links in the StartUp menu,  the 

icon of .dcp files and the ability to launch the latter by double clicking on them (you can 

easily recover the last three features by creating the appropriate menu entries and right 

clicking on a problem file to change the associated program). 

 

Uninstalling Directory Compare 

To uninstall Directory Compare from your hard drive 

1. Use Add or remove programs from the Control panel. 

2. If necessary, remove any remaining files in the installation directory (DirCmp.gid 

and DirCmp.fst, if you have used the help system), as well as any .dcp files you 

might have created.  

3. Advanced users may want to remove the options file: 

 Windows XP: 
C:\Documents and Settings\user\Program data\Juan M. Aguirregabiria\RenJPEG.ini 

 Windows Vista/7:  



C:\Users\user\AppData\Roaming\Juan M. Aguirregabiria\RenJPEG.ini 

Of course, you have to use the right user name.  

To remove Directory Compare, from a portable device delete the files dircmp.exe, 

dircmp0.ini, dircmp.chm and dircmp.pdf. 

 

Running Directory Compare 

You can run Directory Compare as a normal program, from any of the following: 

 The Start menu  

 A shortcut on the desktop  

 A folder 

 Execute dialog box  

 A DOS window (see Command Line Options). 

You can also double-click any file containing saved settings (a .dcp file), which starts 

Directory Compare and loads the settings. 

 

Once Directory Compare starts: 

 Select the source directories by doing one of the following:  

 Click Source (or Multiple) and then select the appropriate directory (or directo-

ries, including those you do not want to be scanned: see Directory lists in 

Source/Target). 

 Enter the directory path in the edit box under the Source button. You may spec-

ify multiple directories separated by ; and directories after / will be excluded 

from the scan (you can use the * and ? wildcards in the latter). You may use the 

Multiple buttons to simplify this task and you can also drag directories (and 

files) files from Explorer (and other programs) and drop them over Directory 

Compare. The Directories dropped dialog box will open. 

 Click the down arrow at the end of the edit box and select a source specification 

from the list. 

 Select the source file mask (or masks separated by ;) under Filter (the default * will 

use all files in the selected directories; patterns after / will be excluded: see File Pat-

terns in Filter),  

 Select the target (backup) directory (directories) by doing one of the following:  

 Click Target (or Multiple) and then select the appropriate directory (or directo-

ries: see Directory lists in Source/Target). 

 Enter the directory path in the edit box under the Target button. You may spec-

ify multiple directories separated by ; and directories after / will be excluded 

from the scan (you can use the * and ? wildcards in the latter). You may use the 

Multiple buttons to simplify this task and you can also drag directories (and 



files) files from Explorer (and other programs) and drop them over Directory 

Compare. The Directories dropped dialog box will open. 

 Clicking the down arrow at the end of the edit box and select a target specifica-

tion from the list. 

 Select the items you want included in the list:  

 Subdirectories if you want to scan also directories under the selected ones, 

 Newer source files to list files that are older or missing in Target, 

 Newer target files to list files that are older or missing in Source, 

 Equal files to list files that have the same time stamp in Source and Target, 

 Press Scan to make Directory Compare search both directories and compare the 

time stamps of files. The results are displayed in a list which shows in each line the 

file name, the relative path and the size and date of the copies existing in both directo-

ries. Data corresponding to Source and Target is separated by one of the following:  

 

Character Meaning 

> the source file is newer than the target file or the latter is missing, 

< the source file is missing or older than the target 

? both files have the same time stamps but different sizes (they will be 

treated as the > files if the Sizes are different option in the Options 

dialog is selected), 

- both files have the same time stamps and sizes but different attributes 

(they will be treated as the > files if the Attributes are different op-

tion in the Options dialog is selected). But see File attributes that 

cannot be copied. 

! files are different but have the same name and the Ignore every-

thing… option is selected. 

# for one FAT file and one NTFS file differing just by one hour. See 

FAT vs. NTFS. 

= both files have the same time stamp, sizes and attributes (although not 

very probable, they could have some different bits: use the Compare 

function to check this). 

The different files will appear selected and the status line will inform you on the number 

of files that are newer in each directory, as well as the equal files and the number of se-

lected files (initially, those with different time stamps). 

When a single Source/Target pair is being used the relative path displayed in the second 

column (if any) must be appended to the source and target directories displayed just 

above the list to get the full path of the files in each line. If multiple source/target pairs 

are being used, no directories is shown above the list, but the directories displayed in the 

second column will start by the number of the corresponding pair followed by a slash 

(and the relative path, if any). For example the second column will display 2/ if the file 

is in the second source/target pair and 10/data\peter if it is in the subdirectory da-



ta\peter of the 10
th

 pair. Notice the normal slash is used between the pair number 

and the relative path and a backslash to separate directories. 

 After changing some settings (as those mentioned above: Subdirectories, Newer 

source files, etc.) you can use the entry Refresh on the Edit menu (or the popup 

menu) to quickly compare again the items stored in memory in the previous scan, 

without reading again the information on the disk(s). See Scan vs. Refresh. 

 Now, you can select or deselect files as usual (remember holding down the Ctrl key 

if you want to keep other selections when changing the status of a single line) and use 

the Edit menu, the shortcut menu that you get when using the right mouse button or, 

in some cases, the equivalent keyboard shortcuts to update and compare files in both 

directories as well as to perform other tasks on them: erasing, opening, viewing, using 

an external compare program. The usual way of arranging the order of entries by 

clicking on column headers works as expected. The columns may also be rearranged. 

Since you may have different sets of working directories (say, your documents and your 

programs) you may find yourself repeatedly using the same sets of directories, filter and 

options. The history lists under Source and Target will help you, and Directory Com-

pare always starts with the settings you used the last time. Furthermore, by using the File 

menu you can save the settings in a .dcp file and then use them again later. You can then 

recover the settings in the file, or by simply clicking on the file icon (you may also define 

a shortcut to this icon in any convenient location, such as your desktop). In that case the 

program will start with the corresponding settings and an automatic Scan will by per-

formed on start-up.  

See also Automatic Backups and Command Line Options. 

 

Directory lists in Source/Target 

You can enter multiple directories separated by a semicolon in Source and Target. This is 

useful to synchronize different directory trees in a single operation. 

In Source and Target, the directories separated by semicolons that follow a slash will 

not be scanned (and the same will happen with the corresponding directories in Target). 

This may be used to avoid synchronizing unimportant data (such as intermediary files 

generated by a compiler) or to excluded system directories. Any subdirectory will also be 

excluded. You can specify either full directory specifications like 

“C:\WINDOWS\SYSTEM32\Restore files” which will exclude just the corre-

sponding directory, or only the directory name as “Restore files” which will ex-

clude “C:\WINDOWS\SYSTEM32\Restore files” but also 

“C:\WINDOWS\SYSTEM32\My Apps\Restore files”. Something like 

“SYSTEM32\Restore files” will not work.  

Remember: you can use the * and ? wildcards in excluded directories. 

For instance, to compare the trees of two programs but excluded the *.obj files in sub-

directories called obj  you can enter 

c:\prog\app1;c:\prog\app2/obj 



in Source and the following in Target: 

d:\prog\app1;d:\prog\app2 

To exclude subdirectories like Debug or Debug_build you may enter 

c:\prog\app1;c:\prog\app2/debug* 

in Source and the following in Target: 

d:\prog\app1;d:\prog\app2 

An easier way to choose multiple directories and/or excluded subdirectories is to press 

any of the Multiple buttons: see Multiple Source/Target dialog box. 

You can also drag directories (and files) files from Explorer (and other programs) and 

drop them over Directory Compare. The Directories dropped dialog box will open. 

 

File Patterns in Filter 

Patterns are used in the Filter edit box to select the files you want included and/or ex-

cluded when comparing directories. A pattern is one or more file masks separated by 

semicolons or a slash. 

A mask is a file name optionally followed by an extension (paths are not allowed, so you 

cannot include \) which may contain any number of copies (including none) of the fol-

lowing wildcards: 

 ? will match any character, but there must be exactly one character. 

 * will match any sequence of characters, including the void one. 

 So, choice?.* will match choices.doc and choice1.dat, but not 

choice.doc. On the other hand, choice*.* will match the previously men-

tioned three files, as well as, choices are good.rtf.  

 * will match any file and *. any file without extension. 

 Spaces at the beginning and the end of a mask will be removed, but you can avoid 

it be putting the mask inside a pair of double quotes, which will be removed. So, to 

match *help.me , with a trailing space, you have to enter it between double 

quotes. 

 A pattern is a single mask or a sequence of masks separated by semicolons. For in-

stance, to match all documents you could use something like 

*.doc;*.txt;*.rtf. 

 If the pattern includes a slash, any file matched by the masks after it will be ex-

cluded. So, to match all documents except the ones containing the letter w, you can 

use *.doc;*.txt;*.rtf/*w*. 

 If the pattern starts with a slash, a default * is added in front of it, i.e., all files will 

be included except the ones matched by the mask(s) after the slash. For example, 

to match all files except the backup files produced by some editors, you might 

want to use /*.bak. To exclude temporary files you may try /*.tmp;*.*~*. 



An easier way to set a complex mask is to press the Filter button: see File filters dialog 

box. 

 

Automatic Backups 

Directory Compare if often used in a friendly interactive way, but it can be also a tool 

for automatic backups to be started 

 by clicking in a shortcut in your desktop, 

 using a menu, 

 when the Windows session starts (by putting a shortcut in the StartUp submenu), 

 by means of the at command under, 

 as a scheduled task, 

 etc. 

In all cases you will have to enter a command line with the program file specification 

and some options. The easiest way is as follows: 

 Prepare in the usual interactive way the kind of copy you want to repeat later once and 

again (including the desired Source and Target, as well as all the remaining options). 

 Check that the settings work as expected. 

 Save the settings to a .dcp file.Say its file specification is 
c:\backups\saveprog.dcp. 

 Select the way to start the automatic task and enter the appropriate command line. 

For instance, 

“c:\Program Files\Directory Compare\DirCmp.exe” 

c:\backups\saveprog.dcp /u /q 

 You can even run the program hidden (at your own risk) by using the /h option. 

 It is also possible to shut down (or hibernate) the computer after the backup by using 

Command line options. For instance you could create a shortcut in your desktop 

with the following command: 
path\dircmp.exe path\exit.dcp /m /x “shutdown –s –f” 

with appropriate paths. In exit.dcp you specify the source and target directories, as 

well as other settings. Then clicking the shortcut will synchronize your directories 

(using the Mirror command in the example) and shut down the computer. (Refer to 

the shutdown command in your system help.) 

You should probably use the features described in Unattended mode in Options dialog 

to avoid the program halting until the user closes a warning or error box. These features 

can also be used to get updates on the process of copying files (useful with vary large 

files). 

Notice that you can use the File/Create shortcut menu to create shortcuts or prepare 

the arguments for Directory Compare, a batch file or another program. The Create 

shortcut dialog will take care of details such as double quotes.   



 

Scan vs. Refresh  

When you click Scan (or press Ctrl+S, or use the menu Edit/Scan) a two step process 

begin: 

1. The directories specified in Source and Target (as well as its subdirectories if Sub-

directories is checked and excluding the directories in Exclude from source and Ex-

clude from Target...) are scanned for files that match the file pattern(s) in Filter. The file 

names and the corresponding information on date, size and attributes are stored in 

memory. 

2. The lists of source and target files are compared, according to the criteria in New 

source files, New target files, Equal files, Options/Configure/Different files and Op-

tions/Configure/Main list.  

When you use the menu Edit/Refresh (or press Shift+Ctrl+R), the second step is re-

peated, with the current settings and the file data stored in memory in the last Scan. This 

is a fast way to compare again the lists of files with different criteria, without having to 

scan again the disk(s), but any change in Source, Target,  Subdirectories and Filter will 

be ignored (until you use Scan again) , since the data stored in memory is only updated in 

the first step of Scan.  

If Options/Refresh after changing the files (Source/Target/Equal) to be shown is 

checked a Refresh will be automatically executed every time New source files, New tar-

get files or Equal files are changed. 

 

Command Line Options 

Directory Compare may be run with optional items in the command line: 

Options Meaning 

dcp_file_name Read the settings in the .dcp file called dcp_file_name 

/d Do not remember current settings the next time the program 

starts. Useful when using it unattended (maybe through the 

Windows Task Scheduler) 

/e file Used with /u, /y or /m, exports the main list contents to file, 

after comparing Source and Target. Command line switch 

equivalent to File/Export. 

/f pattern Use pattern as Filter (see File patterns in Filter). If this is 

not included, * is assumed. 

/h Run hidden. You should probably use the features described 

in Unattended mode in Options dialog to avoid the hidden 

program halting if a warning or error happens. 



See Automatic backups. 

/m Make Target a mirror (exact copy except for newer items in 

Target)  of Source 

/q Quit after performing other actions in command line 

/s directory  Use directory as Source 

/t directory Use directory as Target 

/u Update all newer files in Source 

/x “command” Run command after performing other actions in command 

line (see below). 

/y Update all newer files in Source and Target 

/w Use direct API calls (instead of the shell) to copy and delete 

files: no warning will be issued before deleting files and di-

rectories and no error message will be displayed. Necessary 

for unattended backups. See Unattended mode in Options 

dialog. 

 

(/D, /E, /F, /H, /M, /S, /T, /U,/X,/Y, /Q and /W are also OK.) 

If directory or pattern contain spaces, you must enclose them between double quotes. If 

pattern already contains double quotes they have to be doubled (see below). 

 

Examples (of course, you may need to include the program path explicitly): 

 

Command line Meaning 

dircmp name.dcp Read the settings in the .dcp file and auto-

matically start a Scan. 

Dircmp name.dcp /u Read the settings in the .dcp file, automati-

cally start a Scan and update all newer files 

in Source. 

Dircmp name.dcp /u /q /w Read the settings in the .dcp file, automati-

cally start a Scan, update all newer files in 

Source, and then quit. Issue no er-

ror/warning message. 

Dircmp name.dcp /y Read the settings in the .dcp file, automati-

cally start a Scan and update all newer files 

in Source and Target. 

Dircmp name.dcp /m /q Read the settings in the .dcp file, automati-

cally start a Scan,  update all newer files in 

Source, erase items of Target missing in 

Source, and then quit. 

Dircmp /s "dir 1" Use dir 1 as Source. (Notice the space.) 



dircmp /t dir /f """ a*""/*.bak" Use dir as Target and " a*"/*.bak 

as Filter. 

Dircmp /s dir1 /t dir2 Use dir1 as Source, dir2 as Target, 

and automatically start a Scan. 

Dircmp /s dir1 /t dir2 /u /w Use dir1 as Source, dir2 as Target, 

automatically start a Scan and update all 

newer files in Source with no warn-

ing/error message. 

Dircmp /s dir1 /t dir2 /u /q Use dir1 as Source, dir2 as Target, 

automatically start a Scan, update all new-

er files in Source, then quit. 

Dircmp /s dir1 /t dir2 /y Use dir1 as Source, dir2 as Target, 

automatically start a Scan and update all 

newer files in Source and Target. 

Dircmp /s dir1 /t dir2 /m /q Use dir1 as Source, dir2 as Target, 

automatically start a Scan, update all new-

er files in Source, erase from Target items 

missing in Source, then quit. 

 You can get automatic backups in unattended mode by using a command lines in 

the form dircmp /s dir1 /t dir2 /y /q /w 

or, if extra items in Target must be deleted, dircmp /s dir1 /t dir2 /m /q 
/w 

or, if many options have to be selected, dircmp mybackup.dcp /m /q in a 

shortcut in the desktop, or in a batch file (that, for instance, will be executed automat-

ically from the startup menu, or as a scheduled task, or by means of the at com-

mand).  

 Path specifications containing spaces must be written between double quotes, such as 

in dircmp /s "c:\my programs" /t "d:\backup\my programs" 

The /x "command" options can be used to run a program specified (along with its pa-

rameters) in "command", after completing the other task. It is especially useful to shut 

down (or hibernate) the computer after automatic backups. You could use, for in-

stance, from the command line or through a shortcut 
dircmp name.dcp /u /x "shutdown –s –f" 

to force a shutdown after updating your files (according to the settings in name.dcp). 

Refer to the shutdown command in your system help. See Automatic backups. 

 There are also logging facilities for automatic backups. 

Notice that you can use the File/Create shortcut menu to create shortcuts or prepare 

the arguments for Directory Compare, a batch file or another program. The Create 

shortcut dialog will take care of details such as double quotes.   

 
 

Main Menu 



Entry Meaning 

File Open the File Menu to manage .dcp files 

Edit Open the Edit Menu to update and compare files in both directo-

ries 

Options Open the Options Menu to view and edit options 

Help Open the Help Menu  

 

File Menu 

Use the options on the File Menu to save the current settings to a .dcp file and to restore 

settings that you have previously saved. 

Entry Key Button Meaning 

New   Start a new.dcp file to store settings 

Open   Load previously settings saved to a .dcp 

file 

Save   Save the current settings. These are saved in 

a file with a .dcp file extension 

Save as   Save to the disk the current settings under a 

new name 

Create shortcut   Open the  Create shortcut dialog box to 

create a shortcut or prepare a command line 

for Directory Compare, a batch file or  an-

other program. 

Print Ctrl+P  Print contents of main list 

Export   Save to a text file the main list contents. 

Each line is stored in a text line with ele-

ments separated by tabulators. If the file 

extension is .csv it will be saved in CSV 

format (fields between double quotes sepa-

rated by commas). The file can be easily 

imported in Word, Excel or any data file 

processor. 

Exit   Quit from Directory Compare 

. . .   List of most recently-saved settings files 

 

 

Edit Menu (popup menu) 



This menu is both an entry of the Main Menu and the popup menu which opens when 

you use the right mouse button. It enables you to carry out the main file maintenance op-

erations: 

Entry Key Button Meaning 

Scan Ctrl+S Scan Scan Target and Source and 

compare item stamps. 

Refresh Shift+Ctrl+R  Quickly compare again with cur-

rent settings without reading the 

information on the disks. See 

Scan vs. Refresh. 

Swap Ctrl+W 
 

Swap Source and Target directo-

ries 

Update selected Ctrl+U 
 

Copy, to Target, the selected 

files that have a more recent date 

in Source. Files with the same 

time stamps but different 

size/attributes will also be updat-

ed if the Sizes are differ-

ent/Attributes are different op-

tion in the Options dialog dialog 

is selected. But see File attrib-

utes that cannot be copied. 

Synchronize 

selected 

Ctrl+Y 
 

Copy, to each of the Target and 

Source directories, the selected 

files that have a more recent date 

in the other folder. 

Compare se-

lected 

Ctrl+C 
 

Compare the entire contents of 

those selected files that have the 

same time stamp in both directo-

ries. Only errors are displayed  by 

means of an Error dialog box.  

No news is good news! For the 

same reason, when the source and 

target files have different attrib-

utes, those that are different are 

reported. 

Update all   Copy to Target all files that have 

a more recent date in Source. 

Files with the same time stamps 

but different sizes/attributes will 

also be updated if the Sizes are 

different/Attributes are differ-

ent option in the Options dialog 



dialog is selected. But see File 

attributes that cannot be cop-

ied. 

Synchronize all   Copy to each of the Target and 

Source directories all the files 

that have a more recent date in 

the other folder. 

Compare all   Compare the entire contents of all 

the files that have the same time 

stamp in both directories. Only 

errors are displayed  by means of 

an Error dialog box dialog will 

open.  No news is good news! For 

the same reason, when the source 

and target files have different 

attributes, those that are different 

are reported. 

Mirror Ctrl+I 
 

Like Update all, but items miss-

ing from Source will be 

 ompare eed from Target. Use-

ful to make sure that the target 

directory is completely equal to 

the source and does not contain 

files that are no longer present in 

the source. However, it does 

nothing about files that are newer 

in target. 

Mirror selected Shift+Ctrl+I  Like Mirror, but applies only to 

selected items. 

Change in se-

lected 

  Change in selected items the ac-

tion to be performed by an Up-

date, Synchronize or Mirror 

command to force copying over 

newer items. These are dangerous 

commands and you will have to 

confirm the action. There are five 

commands: 

< to >     
Force copying over newer files 

? to >     
Force copying over files with the same 

time stamp but different file sizes 

- to >     
Force copying over files with the same 

time stamp but different file attributes 



! to >     
Force copying over different files if only 

names and extensions are compared 

# to >     
Force copying over the target in 

FAT/NTFS pairs differing just by 1 hour 

(or differences of integer number of 

hours) 

Select different Ctrl+F 
 Select all files with different time 

stamps or that do not appear in 

both directories. 

Select all Ctrl+A 
 Select all the files in the list. 

Exclude direc-

tories 

 
 Add the selected directories and 

the directories of the selected 

files to the list of excluded source 

and/or target directories. Scan 

again to use the new lists. 

Exclude file 

type 

 
 Add to the list of excluded file 

filters the pattern *.ext for the 

extension .ext of each selected 

file in the main list. Scan again to 

use the new list. 

Delete from 

source and tar-

get 

Ctrl+D  Remove the selected files from 

both directories. The files go to 

the Recycle Bin if available. 

Delete from 

source 

  Remove the selected files from 

the Source directory. The files go 

to the Recycle Bin if available. 

Delete from 

target 

  Remove the selected files from 

the Target directory. The files go 

to the Recycle Bin if available. 

Eliminate from 

source and tar-

get 

  Remove the selected files from 

both directories. The files do not 

go to the Recycle Bin. 

Eliminate from 

source 

  Remove the selected files from 

the Source directory. The files do 

not go to the Recycle Bin. 

Eliminate from 

target 

  Remove the selected files from 

the Target directory. The files do 

not go to the Recycle Bin. 

Open/both 

source and tar-

get 

Ctrl+B  Launch/View the selected source 

and target file(s). (See Options 

dialog box).  

Open/source 

file(s) 

Ctrl+L  Launch/View the selected source 

file(s).  



Open/target 

file(s) 

Ctrl+R  Launch/View the selected source 

file(s).  

Open/context 

menu for source 

F10  Open the Explorer context 

menu for selected source files 

Open/context 

menu for target 

F11  Open the Explorer context 

menu for selected target files 

Open/source 

and target direc-

tories 

  Open Explorer windows for the 

directories of selected source and 

target files 

Open/source 

directo-

ry/directories 

  Open Explorer windows for the 

directories of selected source files 

Open/target 

directo-

ry/directories 

  Open Explorer windows for the 

directories of selected target files 

Send to another 

folder source 

file(s) 

  Copy the selected source file(s) to 

any directory.  

Send to another 

folder target 

file(s) 

  Copy the selected target file(s) to 

any directory. 

External com-

pare 

Ctrl+X  
 

Send source and target files to the 

external (compare) program spec-

ified in the Options dialog box.  

 

 

Options Menu 

In this entry of the Main Menu you find 

Entry Key Button Meaning 

Configure Ctrl+K 
 

Open the Options dialog box to 

view and edit preferences 

Forget position and size   Do not  use the current position and 

dimensions the next time the pro-

gram starts 

History lists   Open the Clean up history lists 

dialog 

 

 

Help Menu 



In this entry of the Main Menu you may find 

Entry Meaning 

Contents Contents of the help system 

Search for Help On Search for keywords in the help system 

Check for updates Check if any newer version is available from the program home. 

If an update is available the Updater dialog box will open 

About The ego box 

 

 

Options dialog box 

This configuration dialog opens when using the Configure entry on the Options menu 

or by pressing Ctrl+K and lets you see and change some program preferences. The fol-

lowing options may be edited from its pages: 

Entry Meaning 

Different files  

Sizes are differ-

ent 

Treat as newer those source files that have the same time stamps 

but different sizes (? Files). 

Attributes are 

different 

Treat as newer those source files that have the same time stamps 

but different attributes (- files). But see File attributes that can-

not be copied. 

Copy only attrib-

utes 

Do not copy files when only the attributes are different. Instead, 

copy just the attributes. 

Ignore time dif-

ferences under 

Time stamps are stored with very high precision under NTFS, but 

are rounded to the nearest multiple of 2 seconds when saved to a 

FAT or FAT32 volume. If you keep the source and target files on 

volumes with different file systems, even after Update and the 

next Scan might report that files are different because they have 

(slightly) different time stamps. To avoid this problem, you have 

to set this option to a value of 2 seconds. See FAT vs. NTFS for 

details. The setting is used with all files if any source-target pair 

has different file systems. 

Ignore always Use the previous setting with all file systems. 

When comparing 

FAT and NTFS 

volumes 

 

Ignore differ-

ences up to n 

hours 

Daylight savings are dealt in different ways under  NTFS and 

FAT/FAT32 file systems. If you keep the original files under 

NTFS and their copies in a FAT drive, and the daylight savings 

changes is made automatically by the system, you should set here 

an appropriate value. See FAT vs. NTFS for details. The setting 



is used with all files if any source-target pair has different file sys-

tems. 

Ignore hours and 

compare minutes, 

seconds, ... (use 

only in special 

cases!) 

Just in case you need it... 

Ignore everything 

except file name 

and extension 

Compare only names and extensions. This may be useful in some 

very special cases and was added because some users asked for it.   

Clear the read 

only attributes in 

copies of files 

from a CD-ROM 

This is what the shell always do; so, at least when using the direct 

API calls described below, you should check this with read only 

CD-ROMs but not with CR-RWs. The setting is used with all files 

copied if any of the source directories is a CD-ROM (CD-R or 

CD-RW). 

Unattended 

mode 

 

Use direct API 

calls to copy and 

delete files 

By default the program uses the shell to copy and delete files and 

directories. If an error happens (for instance trying to delete a file 

being used by another application) a message box appears and the 

program waits until user press the OK button to close it. Moreo-

ver, depending of the settings Ask the user before deleting files 

if they are at least and Ask before deleting directories, the user 

will be prompted before deleting files and directories. All these 

messages and prompts should be avoided in automatic backups 

when the user is not there to close the popup window. This can be 

accomplished by checking this option (or using the /w switch in 

the command line): the operation will be silent, files and directo-

ries will be removed without warning and no error box will dis-

play (but see the description of Log file  and Show warnings and 

errors on screen below). You loose the ability to delete to the 

recycle bin and read only files would not be deleted or overwritten 

unless the Delete/overwrite read only files option is checked. 

Log file If a file specification is provided here and the previous option has 

been selected, the information controlled by the remaining entries 

in this sheet is sent to the log file. If the file already exists the con-

tents is not lost: the new information is appended at the end. If the 

log file does not exist and cannot be created (because the directory 

you specified does not exist, for instance), no error is issued and 

nothing is logged. Notice that Mirror operations are implemented 

as an Eliminate operation followed by Update: two entry series 

will be sent to the log file. 

Log everything Select this to send to the log file every file/directory operation, as 



well any error. 

Log only errors Select this to send to the log files only failed file/directory opera-

tions, with the corresponding error information. 

Log start and end 

times 

Send the date and time of the current log operation start and end. 

Log statistics Send to the log file the number of files/directories that have been 

copied/deleted, as well as the number of errors. 

Show warning 

and errors on 

screen 

Display warning and errors in message boxes when using API 

calls (the program then will wait until the user acknowledges the 

error or warning). 

Show copy pro-

gress 

Display the progress of every copy operation (especially useful for 

large files). 

Delete/overwrite 

read only files 

No warning will be used if this is checked 

Check drive 

ready status 

Check whether drives are ready and issue a warning if not. You 

may want to disable this for unattended backups. 

Check folders 

exist 

Check whether folders exist and issue a warning if not. You may 

want to disable this for unattended backups. 

Main list Specify the relative order to sort the symbols > < ? - ! = 

when listing files. 

Display icons Show the icon corresponding to each item as in Explorer or My 

Computer (it will slow down the display of the main list).  

Show grid lines Separate entries with fine lines 

List, Copy and 

Delete directories 

Treat directories as normal files and display them in the main list, 

so that they can be copied (even if they are empty) and deleted. 

Automatically 

update main list 

after files are 

copied or deleted 

The main list is automatically refreshed each time a file (or a 

group of files) is deleted or a synchronization is performed. If you 

find this annoying, deselect this option: the main list will be up-

dated only when you explicitly ask for it by means of Scan. 

Save sort order Save the sort order of the main list from session to session 

Refresh after 

changing the files 

(Source/Target/E

qual) to be shown 

Whether a Refresh will be automatically executed every time  

Source, Target or Equal are changed. 

Date and time 

format 

Optionally select a date and time format (see the Date and time 

format different from your system default. If the main list is not 

empty you may want to use Edit/Refresh to use the new format. 

File size format Select whether files sizes must be displayed in Bytes (this is the 

default and no suffix is appended), kB (kilobytes with the kB suf-

fix), MB (megabytes with the MB suffix), GB (gigabytes with 

the GB suffix) or by using a Variable format: bytes until 1 kB, 

file:///C:/progu/dircmp/Html/html/format.htm


kilobytes until 1 MB, megabytes until 1 GB or gigabytes. 

Separator Character used to separate thousands in files sizes. Only the first 

character is used (or nothing if left empty). By default your system 

separator. 

Even when they 

are different 

Unless this is checked the file size will be displayed in bytes if the 

sizes of source and target are different (to clearly show the differ-

ence). 

Colors Customize the appearance 

Use colors in 

main list 

If this options is selected (user-defined) colors will be used in the 

main list (instead of a standard list view) to mark different types 

of entries (entries with newer Source, newer Target and so on). 

Changing this option will be taken into account only when a new 

session of Directory Compare starts. 

Choose a line 

type 

Select here a line type and then Text color or Background color 

to customize colors used when the previous option is selected. 

Style Select a style (skin) among the *.vsf files in the styles subdi-

rectory located in the executable folder, if installed by the setup 

program and/or added by you, maybe in a subdirectory, after get-

ting them from internet: see, for instance, 

http://theroadtodelphi.wordpress.com/2011/09/01/exploring-

delphi-xe2-vcl-styles-part-i/ or http://code.google.com/p/vcl-

styles-utils/wiki/VclStylesCollection. 

Display anima-

tions in lengthy 

tasks (not nice 

with many styles) 

Use the old animations when scanning directories, copying files, 

etc. They might not look nice in styles different from the default 

Windows. 

Double click  

When you double 

click on an item 

from the main list 

Select from the list below the action to be performed when you 

double click on an item in the main file list. 

Execute associat-

ed program  

Using any Open command form the Edit menu or the shortcut 

menu starts the associated program to edit the file. 

Quick view the 

file 

Using any Open command starts the associated quick view filter 

to view the file. 

External com-

pare 

 

Select application Use this if you want to specify an external program to use when 

performing a detailed comparison of files by using the Ed-

it/External compare menu or the Ctrl+X shortcut. For exam-

ple, you could use FileComp in my own Console utilities.  

The external program will also be called when using Details in an 

Error dialog box which displays an error while comparing file 

http://theroadtodelphi.wordpress.com/2011/09/01/exploring-delphi-xe2-vcl-styles-part-i/
http://theroadtodelphi.wordpress.com/2011/09/01/exploring-delphi-xe2-vcl-styles-part-i/
http://code.google.com/p/vcl-styles-utils/wiki/VclStylesCollection
http://code.google.com/p/vcl-styles-utils/wiki/VclStylesCollection


contents.  

The source and target full file specifications (or the equivalent 

Windows 3.1-DOS 6 short names) can be specified by means of 

the %s and %t (%S and %T) escape sequences. To insert a true 

percent sign (%) enter %%.  

Remember that often you have to use double quotes around file 

specifications with blanks.  

You may use the Select application button to search through the 

system the compare utility and the program will put them around 

the program specification and add the “%s” “%t” options, which 

will work with most programs. 

Show command 

line before exe-

cuting it 

Select this to make Directory Compare show you the command 

line it is about to use when it needs to perform a detailed 

 ompareson of files. You have the opportunity to modify the 

command line at that time. 

Miscellaneous  

Source. . .in con-

text. . . 

Add the “Source for Directory Compare” entry on the context 

menu for folders. Selecting it, Directory Compare will start with 

that folder as Source. You need administrative privileges to 

change this setting; otherwise, a message suggesting you ask the 

system administrator to set this for you will be issued. 

Target. . .in con-

text. . . 

Add the “Target for Directory Compare” entry on the context 

menu for folders. Selecting it, Directory Compare will start with 

that folder as Target. You need administrative privileges to 

change this setting; otherwise, a message suggesting you ask the 

system administrator to set this for you will be issued. 

Ask the user be-

fore deleting files 

if they are at least 

Before starting to delete or eliminate files, Directory Compare 

will issue a warning if the number of files is at least the value se-

lected here. Use 0 to get no warning at all. 

Ask before delet-

ing directories 

If this option is selected, Directory Compare will issue a warning 

before starting to delete or eliminate directories. 

Start browsing 

folders from cur-

rent directory 

When using the Source and Target buttons the dialog box to 

search for the directory will open from the current directory. (If 

this is not selected it will start from My PC.) 

Start browsing 

Target from cur-

rent Source 

When using the Target button the dialog box to search for the 

directory will open from the current Source. If this is not selected 

it will start from the current Target, but if the previous entry is 

not selected, My PC will be the starting point. 

Use Explorer 

view 

Use an Explorer view to select directories, rather than the usual 

tree view. 

Allow a single If this option is selected and you try to launch it when another 



program instance  copy is already running, the latter will be brought to the fore-

ground and no new copy will start. This option is ignored if the 

program is launched with any command line option. 

Warning if .dcp 

file has changed 

If the current .dcp file has changed a warning will be issued and 

the file can be saved. 

Number of most 

recently used 

.dcp files in the 

File menu 

Number of most recently used .dcp files to be added at the end 

of the File menu. The new value will be used the next time the 

program is used. 

Number of items 

in the Source, 

Target and Filter 

history lists 

Number of most recently used settings stored in the lists displayed 

when the down arrow is clicked in Source, Target or Filter. The 

new value will be used the next time the program is used. 

Automatically 

check for updates 

When should the program check whether a new version is availa-

ble from the program home: 
Never 

Once a year 

Once a month 

Once a week 

Once a day 

Every time the program starts 

When an update is available the Updater dialog box will open. 

 

 

Error dialog box 

If two files are different after using the Compare selected or Compare all options in the 

Edit Menu, this dialog opens. The caption shows the error type, as well as the source 

and target files and some details on the difference between files. The following options 

are available: 

Entry Meaning 

OK Ignore the error and continue with the next file to be compared 

Cancel Ignore the error and stop the comparison process 

Update Copy the source to the target  

Details Run the external program, as defined in the Options dialog box, to per-

form a detailed comparison of file contents when they are different. 

Ignore all Ignore this kind of difference (attributes, sizes, time stamps, contents and 

even file existence) with the remaining files (useful if the source or target 

is a CD-ROM). 

 

 

Multiple Source/Target dialog box 



This dialog opens when any of the Multiple buttons is used and provides an easier way 

to enter multiple Source/Target pairs as well as excluded directories: see Directory lists 

in Source/Target. The dialog box contains four lists where the Source, Target and Ex-

cluded directories can be directly entered (in separate lines) and edited (you can use the 

Ctrl+C to copy and Ctrl+V to paste, as well as other common editing shortcuts, and 

pressing the right mouse button a popup dialog with the common editing command will 

open). Remember: you can use the * and ? wildcards in excluded directories. 

The following options are also available: 

Entry Meaning 

Source Press this to select a source directory, which will be ap-

pended to the list below the button   

Target Press this to select a target directory, which will be ap-

pended to the list below the button   

Guess Fill empty target lines using the path of the first target and 

the filename of the corresponding source 

Excluded from source Press this to select an excluded directory, which will be 

appended to the list below the button   

Excluded from target Press this to select an excluded directory, which will be 

appended to the list below the button   

OK Accept and enter in Source and Target the new directory 

lists 

Cancel Abandon changes and exit the dialog  

Help Show help about the dialog 

 

 

File filters dialog box 

This dialog opens when the Filter button is used and provides an easier way to enter a 

complex mask in Filter: see File Patterns in Filter. The dialog box contains two lists 

where the masks to be included and excluded can be directly entered (in separate lines) 

and edited (you can use the Ctrl+C to copy and Ctrl+V to paste, as well as other 

common editing shortcuts, and pressing the right mouse button a popup dialog with the 

common editing command will open). 

The following buttons are also available: 

Entry Meaning 

OK Accept and enter in Filter the new masks 

Cancel Abandon changes and exit the dialog 

Help Show help about the dialog 

 



Directories dropped dialog box  

You can drag directories and files from Explorer (and other programs) and drop them over 

Directory Compare. They will be added to the list in this form (only the directory of 

dropped files will be added).  

 By default all dropped directories are checked, but if you right click on the list a 

popup menu will open with the following entries: 

o Check selected 

o Check all 

o Uncheck selected 

o Uncheck all 

 Of course, you can also check and uncheck individual items. 

 The currently checked directories will be added to the desired location (and removed 

from the list of dropped items) when one of the following buttons is clicked: 

Button  

Source  

Target  

Excluded from source  

Excluded from target  

 If Replace current value(s) was checked, the corresponding list will be cleared be-

fore adding the checked directories. Otherwise, the latter will be appended to the 

list. 

 The dialog box will be automatically closed when the list is empty, i.e., when all its 

items have been added to some list. 

 The remaining buttons are as follows: 

Button  Meaning  

Close  Close the form  

Help  Help on this form  

 

Hint:  



 For easy of use, if the directories are dropped in the left (right) half of the program 

window the Source (Target ) button will be the default button, so that pressing En-

ter will add them and close the form.  

 

Clean up history lists dialog box 

This dialog opens when the Options/History lists menu item is used. and provides a way 

to remove entries that are no longer necessary from the history lists. You select the items 

to be removed and press the corresponding Delete selected button: 

Entry Meaning 

.dcp files Most recently used .dcp files 

Filters File filters (see File Patterns in Filter) 

Sources Most recently used source directories 

Targets Most recently used target directories 

OK Accept changes in history lists 

Cancel Abandon changes and exit the dialog 

Help Show help about the dialog 

 

 

Updater dialog box 

This dialog will open when an update is available from the program home (this will be 

checked only if the program is running and  the Help/Check for updates menu entry is 

used or a periodic check has been scheduled in Options/Miscellaneous/Automatically 

check for updates). 

Line/Button Meaning 

First line Current and update versions 

Second line Internet link to the updated version setup program. Click to down-

load it. 

Third line Internet link to the last version of portable distribution (see In-

stalling Directory Compare). Click to download it.  

Fourth line Internet link to the program home page. Click to open it in your 

browser. 

Fifth line Displays the downloading progress and its success or failure 

Help Help on the dialog 

Close/Cancel Close the dialog/Cancel the downloading process 



Create shortcut dialog box 

This dialog opens when using the File/Create shortcut menu and can be used to  prepare 

a command line for Directory Compare, a batch file or another program. This can be 

useful for automatic backups. 

 In the following entries, the button on the left may be used to select a file or directo-

ry. 

Entry Meaning 

Shortcut The shortcut file specification 

.dcp file The .dcp file with options  

Source The Source directory/directories 

Filter The file pattern: see File Patterns in Filter  

Target The Target directory/directories 

Log file 
(Optional) log file for to File/Export after performing the selected 

actions: see Command line options 

Action 
Select what to do after scanning: Update/Synchronize/Mirror. 

Choose None if you only want to change some initial options 

Quit after ac-

tion completed 

Exit Directory Compare after performing the action selected in the 

previous entry 

API calls 
Use API calls instead of shell functions: see Unattended mode in the 

Options dialog 

Run hidden See automatic backups 

Forget changes 
Do not remember the settings the next time the program starts: 

see Command line options 

Execute 

Optional command to execute after performing the selected action: 

see Command line options. Some predefined metacommands are 

described below. 

Command line 

Press this button to see the command line generated for the current 

settings. You may copy and paste it (in a batch file, you own 

shortcut,...) 

OK Create the shortcut and close the dialog 

Cancel Close the dialog 

Help Open this help topic 

 The program will add or double necessary double quotes. 



 In Execute you may enter anything, but there are some predefined metacommands 

which may be useful. You may use Command line to see the actual command 

passed to the program. 

Saving your settings (.dcp files) 

Since you may have different sets of working directories, perhaps for different projects 

that you are working on, you may find yourself frequently using different sets of directo-

ries, filter, and options. The history lists under Source and Target will help you, and Di-

rectory Compare will start always with the settings you used the last time. 

Also, by using the File menu, you can save the current settings and then use them again 

later when needed. You save the settings in a file with a .dcp extension, which stores a 

set of directories and the options visible in the main window and in the first sheet of the 

Options dialog. You can then recover the settings by doing either of the following:  

 Open the file from within Directory Compare. 

 Click the file icon (you may also define a shortcut to this icon in any convenient loca-

tion, such as your desktop). In this case the program loads the settings and performs an 

automatic Scan on start-up. You may the use the Edit menu, the shortcut menu that 

displays when using the right mouse button or, in some case, the equivalent keyboard 

shortcuts to update and compare files in both directories. 

Starting with version 3.36, when the program loads a new settings file or is about to exit, it 

creates a temporary .dcp file and compares it when the current one. If they are different a 

warning is issued letting the user save the new file or cancelling the operation. Notice that 

the file may change when a new program version is installed (if new options have been 

added to the program). If you find this annoying, check off Options/Miscellaneous/ 

Warning if .dcp file has changed. 

 

FAT vs. NTFS 

Currently Windows computers use (mainly) two different file systems: FAT (I am includ-

ing here the enhanced FAT32 used in most Windows 98/Me systems and many Windows 

95 computers) which is supported by all Windows versions, and NTFS which is directly 

understood only by NT/2000/XP/Vista/7. Notice that each volume (say each physical or 

logical disk) has its own file system and even if you are running under Windows 9x you 

may be using a NTFS volume through a network and, on the other hand, you may have in 

your NT/2000/XP/Vista/7 workstation floppies and many USB drives, for instance, use 

FAT (not to speak of some networked drives, or even a local hard disk formatted under 

FAT for some reason).  

The trouble is that FAT and NTFS save time stamps with different precision and deal in 

very different ways with daylight savings. 

Time stamps are stored with very high precision under NTFS, but are rounded to the 

nearest multiple of 2 seconds when saved to a FAT volume. If you keep the source and 

target files on volumes with different file systems, even after and Update, the next Scan 

might report that files are different because they have slightly different time stamps.  



To avoid this problem, if you keep original files and copies under different file systems, 

you should set the Ignore time differences under option in the Options dialog box  to a 

value of 2 seconds. This value will be used only when comparing files under different 

file systems. 

As for the daylight savings problem, this is Microsoft's official opinion (Article ID: 

Q129574):  

When Windows NT automatically adjusts for daylight savings time, the times on files on 

Windows NT file system (NTFS) partitions and the events in the event logs are retroac-

tively shifted by one hour, even though the files and event records were created before 

the daylight savings time change.  

NOTE: To configure Windows NT to automatically adjust for daylight savings time, run 

Control Panel, choose Date/Time, and select "Automatically Adjust for Daylight Saving 

Time."  

This behavior occurs because of the way that Windows NT stores time information. All 

times displayed in Windows NT for event log events and files on NTFS partitions are 

computed as offsets to Greenwich Mean Time (GMT). When you set the time on your sys-

tem, you are setting the value for GMT. When you select your local time zone for the sys-

tem, the appropriate number of hours are added or subtracted to the stored GMT value. 

This adjusted time is displayed. When "Automatically Adjust for Daylight Saving Time" 

is selected, an additional hour is added to GMT during daylight savings time (the first 

Sunday in April through the last Sunday in October).  

If you are viewing another machine remotely across one or more time zones through 

Event Viewer, the times for events on the remote system appear relative to your local 

time. In other words, if you are viewing an event remotely that actually occurred at 8:00 

PM Central Daylight Time, the time displayed for the event on your computer will be 

6:00 PM when you view the event from the Pacific Daylight Time zone.  

When Windows95 or Windows NT clients access network resources they are passed the 

GMT time of the file stored on the NTFS partition. When the client receives the time 

stamp in GMT they then adjust the time stamp (+) plus or (-) minus the time zone they 

are set for.  

In the case of WINDOWS NT - it also adjusts for daylight savings time and displays the 

file's time stamp for the correct local time including Daylight Savings Time setting.  

In the case of WINDOWS95 - The time returned by the file system is not adjusted for 

Daylight Savings Time. This feature is by design, and was implemented to work with 

servers such as NetWare that do not support the Daylight Savings time APIs and time 

functions in Windows 95. In this case the files will display off by one hour. this is BY 

DESIGN for WINDOWS95 clients. 

In my opinion, the summary is that Windows 95/98/Me is flawed by design and Win-

dows NT/2000/XP and later have a buggy implementation (because the one hour shift is 

made based on the current time and not on the time being adjusted).    

It is not surprising that comparing files saved under file systems with different bugs is not 

an easy task. 

In my opinion the best way to deal with this problem is to disable the "Automatically Ad-

just for Daylight Saving Time" option in Control Panel/Date/Time in your 



NT/2000/XP/Vista/7 computers. After all, changing the time twice in a year is not that 

difficult, and it may be automatically done if you use one of the many free programs that 

set you system clock by reading the time from Internet by using SNTP or another proto-

col. 

I have not been able to devise a full fix for this problem for users that, for some reason, 

want the "Automatically Adjust for Daylight Saving Time" option selected. To fix it, the 

program would need to know if the one hour shift was included in the file stamp of the 

copy, and to do this it should know if the daylight savings were active when the last copy 

from one file system to the other was made. But how could the program do that? Win32 

saves three time stamps for each file, but none can be used to know when the file was 

synchronized: the creation time tells us nothing about further copies, the last access time 

may be due to a read operation and the last modification time is automatically (and cor-

rectly) reset to that of the original file by most copy routines, including the shell func-

tions used by Directory Compare.  

However, I have implemented a partial cure for the problem: if the if the Ignore differ-

ences up to n exact hours is non-zero, the program will flag as (nearly) equal two files 

under different file systems if their time stamps differ by just a number of hours (plus or 

minus the number of seconds, usually 2, in Ignore time differences under) less or equal 

than n. To make clear that it is not completely sure that their time stamps are essentially 

equal (after all, there is a very small probability that one file was modified, without 

changing its length and attributes, exactly one hour after the last change in the other) in-

stead of the = sign a # will be used in this case. Unfortunately this is not a perfect solu-

tion, because it is of no help for files whose true last modification times differ by less 

than one hour: due to the one hour shift of daylight savings, the program might decide 

that the more recent file is older than the other; but as explained above there is no way (to 

the best of my knowledge) for the program to know which one is really older. 

 

Explorer context menu 

If there is any file in the main list is selected and you use the Edit/Open/context menu 

for source or Edit/Open/context menu for target (or use the F11 or F12 keys), there 

will appear the same menu that opens when right clicking on items in My Computer or 

Explorer views, so that you can use the shell to display items properties, delete them, 

send them to utility programs and so on. Keep in mind, however that there are some limi-

tations: 

Only items in the same directory that the first one will be used, since the shell expects 

only files from a single directory (all file sin an Explorer view are in the same directo-

ry). 

Some functionality is provided by Explorer (rather than by the shell) and will not be 

available in Directory Compare. So you may get less menu entries. 

 



Date and time format 

By default, date and time will be displayed using the format in your system localization, 

but you might prefer a different format in Directory Compare. 

For instance, in my system they are displayed as d/mm/yyyy h:mm:ss, which is fine in 

Spain and when I write a letter in Spanish, but in Directory Compare I use the interna-

tional standard ISO 8601 (which gives better alignment and happens to be also the stand-

ard in Basque;): yyyy-mm-dd hh:mm:ss. 

You may use the Options/Configure/Main List/Date and time format entry to enter 

your format which is composed from specifiers that represent values to be inserted into 

the formatted string. Some specifiers (such as d) simply format numbers or strings. Other 

specifiers (such as /) refer to locale-specific strings from global variables.   

In the following table, specifiers are given in lowercase. Case is ignored in formats, except 

for the am/pm and a/p specifiers.  

Specifier  Displays  

c  The date using the format given by the system short date format, followed 

by the time, using the format given by the system long time format. The 

time is not displayed if the date-time value indicates midnight precisely.  

d  The day as a number without a leading zero (1-31).  

dd  The day as a number with a leading zero (01-31).  

ddd  The day as an abbreviation (Sun-Sat) using the strings given by the system 

short day names.  

dddd  The day as a full name (Sunday-Saturday) using the strings given by the 

system long day names.  

ddddd  The date using the format given by the system short date format.  

dddddd  The date using the format given by the system short date format.  

e  The year in the current period/era as a number without a leading zero (Jap-

anese, Korean, and Taiwanese locales only).  

ee  The year in the current period/era as a number with a leading zero (Japa-

nese, Korean, and Taiwanese locales only).  

g  The period/era as an abbreviation (Japanese and Taiwanese locales only).  

gg  The period/era as a full name (Japanese and Taiwanese locales only).  

http://en.wikipedia.org/wiki/ISO_8601


m  The month as a number without a leading zero (1-12). If the m specifier 

immediately follows an h or hh specifier, the minute rather than the month 

is displayed.  

mm  The month as a number with a leading zero (01-12). If the mm specifier 

immediately follows an h or hh specifier, the minute rather than the month 

is displayed.  

mmm  The month as an abbreviation (Jan-Dec) using the strings given by the sys-

tem short month names.  

mmmm  The month as a full name (January-December) using the strings given by 

the system long month names.  

yy  The year as a two-digit number (00-99).  

yyyy  The year as a four-digit number (0000-9999).  

h  The hour without a leading zero (0-23).  

hh  The hour with a leading zero (00-23).  

n  The minute without a leading zero (0-59).  

nn  The minute with a leading zero (00-59). 

s  The second without a leading zero (0-59).  

ss  The second with a leading zero (00-59).  

z  The millisecond without a leading zero (0-999).  

zzz  The millisecond with a leading zero (000-999).  

t  The time using the format given by the system short time format.  

tt  The time using the format given by the system short date format.  

am/pm  Uses the 12-hour clock for the preceding h or hh specifier, and displays 

'am' for any hour before noon, and 'pm' for any hour after noon. The 

am/pm specifier can use lower, upper, or mixed case, and the result is dis-

played accordingly.  

a/p  Uses the 12-hour clock for the preceding h or hh specifier, and displays 'a' 



for any hour before noon, and 'p' for any hour after noon. The a/p specifier 

can use lower, upper, or mixed case, and the result is displayed according-

ly.  

ampm  Uses the 12-hour clock for the preceding h or hh specifier, and system 

string for any hour before/after noon.  

/  The date separator character given by the system date separator.  

:  The time separator character given by the system time separator.  

'xx'/"xx"  Characters enclosed in single or double quotation marks are displayed as 

such, and do not affect formatting.  

 

 

Invalid argument to data encode dialog box 

On rare occasions you might get the following error message: Invalid argument to data 

encode. 

This will happen if the file somehow got an invalid date or time stamp, such as a year pre-

vious to 1900. Just press OK and the file will be processed (copied, deleted, etc.) as usual.  

The message won't be issued if Use direct API calls to copy and delete files is checked 

and Show warnings and errors on screen is not checked. 

(You might also use a program like my own freeware Touch to correct the bad stamp.) 

 

File attributes that cannot be copied 

 According to Microsoft documentation there are some file/directory attributes that 

cannot be copied with the API function SetFileAttributes by obvious reasons: 

FILE_ATTRIBUTE_COMPRESSED, FILE_ATTRIBUTE_DEVICE, 

FILE_ATTRIBUTE_DIRECTORY, FILE_ATTRIBUTE_ENCRYPTED, 

FILE_ATTRIBUTE_REPARSE_POINT and 

FILE_ATTRIBUTE_SPARSE_FILE.  

 We have found that, in some systems, the same happens with 

FILE_ATTRIBUTE_NOT_CONTENT_INDEXED and 

FILE_ATTRIBUTE_ARCHIVE, although the Microsoft documentation doesn’t 

mention it. 

 Directory Compare does not check attributes if the Options/Configure/Different 

files/Attributes are different option is not checked: the files will be assumed to 

http://tp.lc.ehu.es/jma/win95.html
http://msdn.microsoft.com/en-us/library/windows/desktop/aa365535%28v=vs.85%29.aspx


be equal if their dates (and sizes if Options/Configure/Different files/Sizes are 

different is checked).  

 However, the difference in attributes will be shown (but cannot always be eliminat-

ed) when Edit/Compare selected or Edit/Compare all is used.  

 

Suggestions, bugs and help 

The author would highly appreciate receiving information about any bug or problem 

found in the program. Suggestions to improve Directory Compare in future versions are 

also welcome.  


